Roxio
Popcorn®4

Getting Started Guide
Legal Information

Copyright ©1994 - 2009 Sonic Solutions. All Rights reserved. Use of this product is subject to your agreement to all of the terms of each of the license agreements included in this package. This product may be protected by one or more US and/or foreign patents.

Trademarks

Fit-to-DVD is a trademark owned by Sonic Solutions which may be registered in some jurisdictions. Roxio, the burning disc logo, Sonic, Sonic Solutions, Toast, the toaster with discs logo, and Popcorn are registered trademarks owned by Sonic Solutions in the United States, and other jurisdictions.

Third-party trademarks and technologies

Macintosh, Mac, Mac OS, the Mac logo, iMovie, iDVD, iLife, iTunes, Final Cut, Final Cut Pro, Apple TV, iPhone, iPod, QuickTime, Leopard, and Snow Leopard are trademarks of Apple, Inc. registered in the US and other countries.

Portions of this software ©2009 TiVo Inc. TiVo, the TiVo logo and TiVoToGo are trademarks or registered trademarks of TiVo Inc. and its subsidiaries worldwide.

PSP, PlayStation 3, and Memory Stick are trademarks of Sony Computer Entertainment, Inc.

Palm and Pre are among the trademarks or registered trademarks owned by or licensed to Palm, Inc.

BlackBerry is a registered trademark of Research in Motion Limited.

‘Dolby’ and the double-D symbol are trademarks of Dolby Laboratories.

This product contains one or more programs protected under international and U.S. copyright laws as unpublished works. They are confidential and proprietary to Dolby Laboratories. Their reproduction or disclosure, in whole or in part, or the production of derivative works therefrom without the express permission of Dolby Laboratories is prohibited. Copyright 1992-1997 by Dolby Laboratories, Inc. All rights reserved.

Manufactured under license from Dolby Laboratories.
AVCHD, AVCHD Lite and the AVCHD logo are trademarks of Matsushita Electric Industrial Co., Ltd. and Sony Corporation. The AVCHD Logo is used under license.

YouTube and the Powered by YouTube logo are trademarks of Google, Inc.

Adobe and Flash are registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Ogg Vorbis audio compression technology provided courtesy of the Xiph.Org Foundation.

libvorbis and libogg
Copyright (c) 1994-2004 Xiph.org Foundation

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

libflac and libflac++

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Changes

The material in this document is for information purposes only and is subject to change without notice. While reasonable efforts have been made in the preparation of this document to assure its accuracy, Sonic Solutions assumes no liability resulting from errors or omissions in this document, nor from the use of the information contained herein.

Sonic Solutions reserves the right to make changes in the product design without reservation and without notification to its users.

Disclaimer

THIS PRODUCT DOES NOT BYPASS OR CIRCUMVENT COPY PROTECTION. THIS PRODUCT DOES NOT ENABLE YOU TO COPY DVDS CONTAINING CSS-ENCRYPTION OR OTHER COPY-PROTECTED CONTENT. IF THIS PRODUCT ALLOWS YOU TO COPY ANY CONTENT, YOU MAY DO SO ONLY IF YOU OWN THE COPYRIGHT, YOU HAVE OBTAINED PERMISSION TO COPY FROM THE COPYRIGHT OWNER, OR YOU HAVE THE LEGAL RIGHT TO MAKE SUCH A COPY. IF YOU ARE NOT THE COPYRIGHT OWNER OR YOU HAVE NOT OBTAINED PERMISSION TO COPY FROM THE COPYRIGHT OWNER, YOU MAY BE VIOLATING COPYRIGHT AND OTHER LAWS AND YOU MAY BE SUBJECT TO CLAIMS FOR DAMAGES AND/OR CRIMINAL PENALTIES. ANY ILLEGAL USE OF THIS PRODUCT IS STRICTLY PROHIBITED. IF YOU ARE UNCERTAIN ABOUT YOUR RIGHTS, YOU SHOULD CONTACT YOUR LEGAL ADVISOR. YOU ASSUME FULL RESPONSIBILITY FOR THE LEGAL AND RESPONSIBLE USE OF THIS PRODUCT.
Contents

What is Popcorn? .................................................. 6
System Requirements ............................................ 6
Installing Popcorn ................................................ 7
Getting to know the Popcorn window ................. 8
What types of video can Popcorn use? ............. 10
Popcorn Extras ...................................................... 10
Using the Media Browser ................................... 12
Copying to a DVD ............................................... 15
Creating a disc image file ................................. 16
Changing copy options for a DVD .................... 17
Creating a DVD-Video Disc from Video Files ..... 19
Changing recording settings ...................... 21
Sharing recorders ............................................... 22
Converting video ................................................. 23
Device Export Profiles .................................... 25
Changing copy options for a portable player .... 29
Troubleshooting tips ........................................... 31
Support options ................................................... 32
What is Popcorn?

Popcorn® provides Mac users with the best method yet to copy DVDs and convert videos.

Using Fit-to-DVD™ compression technology, you can now burn an entire 9 GB DVD-Video onto a 4.7 GB recordable DVD. Popcorn also helps you extract video clips and music from DVDs, convert AVCHD and MKV video, publish video directly to YouTube and more.

System Requirements

To use Popcorn, you will need the following hardware and software:

- Macintosh® computer with an Intel® processor
- Mac OS X v10.5 (Leopard®) or 10.6 (Snow Leopard™)
- Up to 800 MB of free disk space to install all components
- Up to 15 GB of temporary free disk space during usage
- QuickTime® 7
Installing Popcorn

To install Popcorn:

1. Insert the installation disc into your drive. Or, if you purchased a downloadable version of Popcorn, double-click the .dmg file. The Popcorn window appears on your Desktop.

2. Drag the Popcorn 4 folder to the Applications folder on your hard disk.

3. In the Applications folder on your hard disk, open the Popcorn 4 folder and double-click the Popcorn icon to launch the software.

4. Follow the on-screen instructions to set up Popcorn the first time.

5. You will be asked to accept the license agreement and enter a CD key. You can find the CD key in one of the following locations:
   - If you purchased a boxed version of Popcorn, your product key is printed on the back of the disc sleeve.
   - If you purchased Popcorn via download, your product key is included with your purchase confirmation e-mail.

If you purchased an upgrade version of Popcorn, you may also be asked to enter your CD key from a prior version of Toast or Popcorn.

Note: This Setup Assistant can be run at anytime by choosing Help > Popcorn Setup Assistant.
Getting to know the Popcorn window

The Popcorn main window contains the following components:

**Formats and Settings Area**

The Formats and Settings area, located on the left side of the window, displays your available project types and the options for those projects. There are two categories available and the various projects available within each of these is described in the tables, below:

**Copy Projects**

This category includes projects for copying DVD-Video sources and video files to DVD. Optionally, you can compress them to fit on 4.7 GB DVD discs.

<table>
<thead>
<tr>
<th>Video Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD Disc</td>
<td>Allows you to copy an unprotected DVD-Video disc to a blank DVD-Video or image file.</td>
</tr>
<tr>
<td>Image File</td>
<td>Allows you to create a DVD-Video disc from a DVD-Video image file.</td>
</tr>
<tr>
<td>VIDEO_TS Folders</td>
<td>Allows you to create a DVD-Video disc or DVD image files from one or more DVD-Video (VIDEO_TS) folders.</td>
</tr>
<tr>
<td>VIDEO_TS Compilation</td>
<td>Allows you to select multiple DVD-Video folders and burn them to a single DVD.</td>
</tr>
<tr>
<td>DVD-Video</td>
<td>Allows you to create a DVD-Video disc from a selection of your own video files, including AVCHD video from your HD camcorder.</td>
</tr>
</tbody>
</table>
Convert Projects
This category includes projects for converting DVD-Video sources and video files to DVD. You can also convert video and audio files to other formats, and choose to convert your project for playback on Mac or portable devices.

<table>
<thead>
<tr>
<th>Video Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD Disc</td>
<td>Convert an unprotected DVD to a video file for playback on your Mac or a portable device.</td>
</tr>
<tr>
<td>Image File</td>
<td>Convert a DVD-Video image file to a video for viewing on your Mac or a portable device.</td>
</tr>
<tr>
<td>VIDEO_TS Folders</td>
<td>Convert one or more DVD-Video (VIDEO_TS) folders to video files for playback.</td>
</tr>
<tr>
<td>Video Files</td>
<td>Convert video files to another format.</td>
</tr>
<tr>
<td>Audio Files</td>
<td>Convert audio files to another format.</td>
</tr>
</tbody>
</table>

Content area
The content area is located on the left side of the window. For most projects, this is where you drag your files to add them to the project.

Space Indicator
The space indicator is located along the bottom of the window, and displays the amount of content that has been added to the current project. For DVD projects, you can toggle between single- and dual-layer DVDs to calibrate for your target disc type.

Record Button
Located on the lower right-hand side of the window, the Record button will begin recording your disc. For video conversion projects, click this button to begin converting your video.
What types of video can Popcorn use?

Popcorn can copy DVD-Video to a blank recordable DVD, including:
- DVD-Video discs created with Toast®, iDVD®, or DVD Studio Pro®
- Commercial DVD-Video discs that are not copy-protected or encrypted
- DVD-Video image files or VIDEO_TS folders from your hard disk

Popcorn can convert DVD-Video and other video files for use on portable players, including:
- DVD-Video discs created with Toast®, iDVD®, or DVD Studio Pro®
- Commercial DVD-Video discs that are not copy-protected or encrypted
- DVD-Video image files or VIDEO_TS folders from your hard disk
- Native QuickTime file formats, such as DV, MOV, H.264 and MPEG-4
- Other non-QuickTime file formats, including, but not limited to: MPEG-2, AVCHD, AVCHD Lite, MKV and some types of FLV.

To copy a DVD-Video or video file to a blank DVD, see Copying to a DVD on page 15.

To convert a DVD-Video or other video file for use on an iPod, iPhone, Apple TV, or other device, see Converting video on page 23.

Popcorn Extras

Popcorn includes additional applications to help you save, share, and enjoy your digital media. They can easily be accessed from the Extras menu.

Disc Cover 2 RE Disc Labeling Software

Disc Cover RE creates stunning disc labels and case covers for printing or laser-etching to LightScribe- and LabelFlash-enabled drives and media. For more information on LightScribe, visit http://www.lightscribe.com.
TiVoToGo for Mac

Transfer recorded television shows to your Mac from a TiVo® Series2™, Series3™, TiVo HD DVR or other TiVoToGo-compatible DVR connected to your home network. Watch recordings on your Mac, cut and trim them to remove unwanted segments, burn them to a DVD, or convert them for viewing on a portable device.

Mac2TiVo

Send standard and HD video from your Mac to your TiVo DVR for viewing on your television. Publish folders full of compatible video on your Mac and stream them on-the-fly to your DVR without lengthy video conversions.
Using the Media Browser

The Media Browser provides quick access to video stored on your computer. You can easily drag and drop content from the Media Browser into the Content Area.

To use the Media Browser:

1. Open the Media Browser window by choosing **Window > Show Media Browser**, or press **Ctrl+S**.

2. From the Media Type pop-up menu, choose the type of media you want to browse:

   - **Movies**: Browse videos and iMovie projects in your Movies folder.
   - **EyeTV**: Browse recorded TV shows from EyeTV. This option is only visible if you have EyeTV digital television recorder software installed (see [www.elgato.com](http://www.elgato.com) for more information).
   - **TiVo**: Browse recorded TV shows that have been transferred from your TiVo. This option requires a TiVo® DVR that supports TiVoToGo™ (see [www.tivo.com](http://www.tivo.com)).
■ **DVD**: Browse unprotected DVD-Video discs, mounted disc images, DVD-Video (VIDEO_TS) folders, or select and mount DVD-Video images.

**Tip:** When adding these sources to a Popcorn project, you will be able to browse entire discs, titles and chapters in order to select and extract clips and/or music from unprotected DVDs.

**Note** You can also access discs from set-top DVD recorders or DVD camcorders. Popcorn includes special support for these discs, which normally are not usable in the Mac OS. Insert these discs in your recorder while Popcorn is running, and then import video from them with the Media Browser.

■ **Files**: Browse files and folders on your local hard disk, external discs, or connected network volumes.

■ **Spotlight**: Search for files or folders by entering a search term in the text field at the bottom of the Media Browser window.

■ **AVCHD**: Browse high-definition video content stored on your connected AVCHD camcorder or AVCHD Lite camera.

3 When browsing movies or DVDs, you can filter the media list by choosing a folder or specific DVD, title or chapter from the second pop-up menu.

**Note** When the File Browser is selected, the second pop-up menu allows you to navigate folders on your system. When Spotlight is selected, the second and third pop-up menus allow you to narrow your search to a specific location or media type.

4 Select any item in the file list and drag it to the Content Area to add it to a project, or click the **Add** button at the bottom of the Media Browser.

You can select multiple items by holding down the **Command** (Apple) key while clicking, and then drag the entire selection to the Content Area.
You can select groups of items by clicking on the first item in the group and then holding down the **Shift** key while clicking on the last item in the group, and then drag the entire selection to the Content Area.

You can preview most media files by double-clicking them in the file list or by clicking the **Preview** button at the bottom of the Media Browser.

Popcorn will display progress information while the items are being added. If the content is being added from a disc (such as from a set-top DVD recorder) this may take several minutes, as it is imported from the disc onto your hard disk.

Imported items from a disc are temporarily stored in the Roxio Converted Items folder in your Documents folder and can be very large. The original source content is not deleted from your disc.

You can configure when Roxio Converted Items is emptied through Popcorn’s preferences, which can be accessed by choosing **Popcorn > Preferences.**
Copying to a DVD

This section explains how to copy a DVD-Video disc, disc image file, DVD-Video (or VIDEO_TS) folders, or video files to a blank recordable DVD disc for playback in a DVD player. Popcorn can copy non-encrypted DVD-Video content.

To learn more about DVD-Video, refer to:

To convert a DVD-Video or other video file for use on an iPod, iPhone, Apple TV, or other device, see Converting video on page 23.

To copy to a DVD:

1. Launch Popcorn and select one of the following projects from the Copy project category:
   - Choose DVD Disc to copy a DVD-Video disc in your DVD drive. If you choose this option, insert the original DVD-Video disc into your DVD drive.
   - Choose Image File to copy a DVD-Video disc image file from your hard disk. If you choose this option, drag a disc image from your hard disk into the content area.
   - Choose VIDEO_TS Folders to copy one or more valid DVD-Video (or VIDEO_TS) folders from your hard disk to DVD. If you choose this option, drag one or more VIDEO_TS folders from your hard disk into the content area. If you have added multiple VIDEO_TS folders, you can choose to save as an image file and they will be batch-processed.
   - Choose VIDEO_TS Compilation to copy one or more valid DVD-video (or VIDEO_TS) folders from your hard disk to a single DVD.

2. A summary of the content that will be copied appears in the content area. In the case of video files, each of your video files will be listed.

If your DVD-Video source is greater than 4.7 GB in size, a message in the Summary area indicates that automatic compression may be needed. After you insert a blank DVD, Popcorn determines if you are
using single-layer or dual-layer media. If you are using a 4.7 GB single-layer disc, Popcorn will compress your video to fit onto the disc. If you are using an 8.3 GB dual-layer media, no compression will occur.

To copy the entire DVD-Video source, including all menus, video and audio, proceed to Step 3.

You can optionally choose to include or exclude specific video, audio and languages. Removing this extra content reduces the amount of compression required and maximizes quality and available disc space. To learn more, see Changing copy options for a DVD on page 17.

3 Click the large red Copy button, choose a recorder from the list, and click Record to continue.

Note You can use the same recorder to read the source DVD and burn to the blank DVD. Popcorn will copy the original disc to a temporary location on your hard disk.

You can optionally choose recording settings, such as Number of Copies. To learn more, see Changing recording settings on page 21.

4 When prompted, insert a blank DVD-recordable disc.

Popcorn displays a progress bar as it records your disc.

Creating a disc image file

Instead of copying to a DVD-recordable disc, you can create a disc image file and store it on your hard disk. You can copy this image to disc or mount it and view the contents at a later time.

To save a disc image file:

1 Start to copy as you normally would, as explained in Copying to a DVD on page 15.

2 Instead of clicking the red Copy button, choose File > Save As Disc Image.

The Save Disc Image As dialog appears.
3. Enter a name in the Save As field and browse to the location on your hard disk where you want the disc image file to be saved.

4. Click Save to continue.

5. A dialog box may appear asking whether you want to create single-layer or double-layer discs from the image file. The best choice depends on the type of drive you have, your plans for the image file and the size of its contents. If you choose double-layer, compression will be minimized, but the file may not fit on a single-layer disc. If you choose single-layer, compression will be set automatically to the level needed to fit the contents on a single-layer disc. Choose the option that best meets your needs.

   Popcorn displays a progress bar as it saves your disc image.

   To copy this disc image at a later time, see Copying to a DVD on page 15.

To mount an image file:

- Control-click on the image file and choose Mount It from the menu.

   Mounted images behave like an actual physical disc inserted into your DVD drive and appear on the Desktop.

To unmount an image file:

- Drag the disc icon to the Trash in the Dock.

Note: Do not drag the disc image file to the Trash unless you want to delete the image file from your hard disk.

---

Changing copy options for a DVD

Fit-to-DVD compresses video to fit on a standard 4.7 GB recordable DVD. Compression may result in a slight reduction in video quality, but will leave the audio quality unchanged. By default, the entire disc is copied, with all menus, video, and audio. You can choose to exclude specific video, audio,
and languages. Excluding unnecessary content reduces the amount of compression required and maximizes quality and available disc space.

To change copy options:

1. After launching Popcorn and selecting a DVD project, click **Use Fit-to-DVD video compression** and add your source to the Content Area.
2. Click **Options**.
3. Select the Video pop-up and choose the video to include:
   - **All**: Select to include all video. All menus will be included.
   - **Main**: Select to include only the single-longest running video. Menus will not be included.
   - **Custom**: Select to choose the specific videos to be included. Menus will not be included.

   **Note** If you choose Main or Custom, the copied disc will not have a menu, but the first video will play automatically when the disc is inserted. If the disc contains multiple videos, all videos will play continuously, in sequence. You may be able to use the Title menu in your DVD player to select a video.

4. Select the Audio pop-up and choose the audio to include:
   - **All**: Select to include all audio for each video.
   - **Main**: Select to only include the primary audio for each video (typically the highest quality Dolby Digital). Secondary audio, such as director’s commentary, or other audio formats such as PCM or DTS® audio will be excluded.
As you make selections, the amount of compression needed and the video quality indicator change. If you choose to only include the main movie or reduce the number of languages and audio, the indicator shows improved quality for the resulting DVD.

5  Click OK to continue and proceed with your copy.

Creating a DVD-Video Disc from Video Files

A standard DVD-Video disc can hold approximately 240 minutes (4 hours) of video as well as Dolby Digital sound and full menu navigation. If your recorder supports dual-layer recordable DVDs, you can create a DVD-Video with approximately double this amount of content. This section explains how to compile and burn videos to a DVD-Video, including those from an AVCHD camcorder.

To make a DVD-Video:

1  Launch Popcorn and select the DVD-Video project from the Copy project category.

2  Add your video files to the project area by dragging video files from your hard disk or Media Browser to the content area.

3  Choose optional disc settings:

   - **Automatic Encoding**: Choose this option to use all video and audio encoding settings that maximize quality and fit the most
content on the disc. Variable bit rate encoding is used for video, Dolby Digital 192 Kbps is used for audio, and aspect ratio is determined automatically from the source videos.

- **Custom Encoding**: Choose this option to manually set video and audio encoding options. Click on the current settings to modify them.

- **Video Quality**: Popcorn must compress video to fit onto the DVD. Choose the quality you want. Better quality takes longer to process.
  - **Good**: Suitable for simple video, such as people talking – fastest processing time.
  - **Better**: Suitable for most video – average processing time.
  - **Best**: Suitable for complex video, such as fast motion – lowest processing time.

- **Menu Style**: Choose the style for the menu background image, text, and buttons.

- **Auto-Play disc on insert**: Select this option to automatically play the first video or slideshow when this disc is inserted into a DVD player. The DVD main menu is not displayed, but is accessible by choosing the **Menu** button on the DVD player remote control. Some players may not support Auto-Play.

- **Play all items continuously**: Select this option to automatically play each video or slideshow on the DVD without first returning to the DVD's main menu.

Additional options are available by clicking the **More** button.
Changing recording settings

You can view or change your recording settings, such as which recorder to use, number of copies to record, or what Popcorn does after recording is complete.

To change recording settings:

1. Click the Recording Settings button, and select Recorder Settings from the menu that appears.

2. Click the Basic tab. You can change basic recording settings, including:
   - **Recorder**: Select the recorder you want to use.
   - **Write Speed**: Select the recording speed. By default, Popcorn will use the best speed, which is the fastest speed that your recorder and the blank media both support. For example, if your DVD recorder supports 1x, 2x, 4x, and 8x, and the blank disc only supports 1x and 2x, then Popcorn will record at 2x speeds. To choose a specific write speed, first insert the blank disc into your recorder. After a few seconds, the pop-up will list all speeds available for your recorder and the current blank media.
   - **Number of Copies**: Enter the number of copies of the disc you want to make. Popcorn will prompt you for blank discs after each copy.

3. Click the Advanced tab. You can change advanced recording settings, including:
   - **After Writing**: Select what you want to do with the disc after recording it. Popcorn can mount the disc on the desktop, eject the disc, or prompt you for either.
   - **Enable Buffer Underrun Prevention**: Select this check box to turn on buffer underrun prevention. A buffer underrun error occurs when your hard disk is unable to send data fast enough to the recorder while recording, causing the blank disc to be...
Roxio Popcorn Getting Started Guide

www.roxio.com

This option is available only if your recorder supports buffer underrun prevention, and should be used for best results.

- **Display Recorder Settings Before Writing:** Select this check box if you want to display the Recorder Settings dialog each time you click the red Copy button.

4 Click OK when you are finished.

### Sharing recorders

Popcorn includes ToastAnywhere™ recorder sharing technology, which lets you record to an available DVD recorder from Toast users on your local network.

**To use a shared recorder:**

1 Click the red **Copy** button.

2 In the Recorder Settings dialog, choose a recorder from the list and click **Record** to continue.

**Note** This list contains recorders connected directly to your system and any shared recorders from Toast users on the same local network.

3 The person using the computer with the shared recorder you have selected will be prompted to insert a blank disc. Popcorn displays a progress bar as it records your disc over the network.
Converting video

This section explains how to convert DVD-Video and other video files into other formats for playback on your Mac or portable devices (i.e. iPods, iPhones, etc...).

Once Popcorn has converted video to the selected format, such as MPEG-4, H.264, you can then transfer it to your portable device.

To copy a DVD-Video to a blank recordable DVD, see Copying to a DVD on page 15.

To convert video for a portable player:

1. Launch Popcorn and select one of the following projects from the Convert project category:
   - Choose DVD Disc to convert an unprotected DVD-Video disc in your DVD drive. If you choose this option, insert the original DVD-Video disc into your DVD drive.
   - Choose Image File to convert a DVD-Video disc image file from your hard disk. If you choose this option, drag a disc image from your hard disk into the content area.
   - Choose VIDEO_TS Folders to convert a valid DVD-Video (or VIDEO_TS) folder from your hard disk. If you choose this option, drag one or more VIDEO_TS folders from your hard disk into the content area.
   - Choose Video Files to convert one or more individual video files from your hard disk. If you choose this option, drag and drop the video files from your hard disk or Media Browser into the content area. If you add multiple files for conversion, Popcorn will convert them in batch mode, successively.

A summary of the information that will be converted appears in the content area.
If you are converting a DVD-Video source, you can choose which audio and video to include. By default, the main video and audio are included. To learn more, see Changing copy options for a portable player on page 29.

2 Click the large red Copy button and choose your player settings.

3 Complete the following steps:
   
a Choose a Device from the pop-up list that most closely matches your portable device or destination. If your specific device is not listed, you may wish to choose MPEG-4, or H.264 player options. For more information on device presets, see Device Export Profiles on page 25.

   b Choose a quality level from the pop-up list. You will see a summary of the video and audio settings for the quality level you select. If you are unsure that you have selected the correct quality, you can play back a small preview to see how your converted video will look before beginning the full conversion.

   Note You may wish to use the preview option on this screen. The Video Quality Preview encodes a small portion of your video so you can assess the conversion quality. You can also save the preview to your hard disk for playback on another video player or portable device.

   c Select a Save To destination from the pop-up list. If you are exporting to your iPod, iPhone, or Apple TV, you should keep the default iTunes choice so that converted video is automatically added to your iTunes library.

4 Click Convert to continue.

Popcorn displays a progress bar as your video is converted.

Encoding can be paused at any time to free up the CPU for other tasks and then resumed later. When encoding is paused, you can run other applications or even switch to another user account as long as Popcorn
remains open. If you close the Popcorn application, even when video encoding is paused, you must restart the process from the beginning.

Tip: Schedule video conversions to run at a later time through the Player Setup window. Once you've selected the device, video quality, and Save To destination, click the Schedule button.

Note Popcorn supports Elgato Turbo.264 and Turbo.264 HD to accelerate H.264 encoding. You must have the Turbo.264 video encoder hardware connected to a USB port on your Mac before beginning your project. See www.elgato.com for more information.

**Device Export Profiles**

The Device options listed below can be selected from the Player Setup window. For information on transferring video to portable devices and players, refer to the documentation included with the device.

<table>
<thead>
<tr>
<th>Device Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple TV</td>
<td>This selection should be used when exporting video for playback on the Apple TV. Select iTunes as your destination to have your video added directly to your iTunes library.</td>
</tr>
<tr>
<td>iPhone / iPod touch</td>
<td>This selection should be used when exporting video for playback on the iPhone or iPod touch. Select iTunes as your destination to have your video added directly to your iTunes library.</td>
</tr>
<tr>
<td>Device Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Video iPod</td>
<td>This selection should be used when exporting video for playback on an early generation iPod, an iPod Classic or iPod Nano. Select iTunes as your destination to have your video added directly to your iTunes library.</td>
</tr>
<tr>
<td>PlayStation 3</td>
<td>This selection should be used when exporting video for playback on a PlayStation 3. To watch the video on the PlayStation 3 you can copy it to a USB flash drive, FAT32 formatted USB external hard disk, CD, or DVD. Some models also support video playback from Memory Stick, SD and Compact Flash cards.</td>
</tr>
<tr>
<td>PSP and PSP Go</td>
<td>These selections should be used when exporting video for a PSP or PSP Go. To watch video on these devices you will typically connect them to your Mac using a USB cable and transfer the video to that device. For more information, including what folders you need to copy video into, please refer to the user guide included with the device.</td>
</tr>
<tr>
<td>Xbox 360</td>
<td>This selection should be used when exporting video for playback on an Xbox 360. To watch the video on the Xbox 360 you can copy it to a USB flash drive, FAT32 formatted USB external hard disk, CD, or DVD.</td>
</tr>
<tr>
<td>Wii</td>
<td>This selection should be used when exporting video for playback on a Nintendo Wii. To watch video on the Wii you can copy it to an SD or SDHC (up to 32 GB) card.</td>
</tr>
<tr>
<td>Device Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BlackBerry</td>
<td>This selection should be used when exporting video for playback on a BlackBerry device. From the Quality selection, you'll need to select the screen resolution of the BlackBerry device to ensure that the video is formatted correctly for your model of device. If you are unsure of the correct screen resolution, please refer to the device documentation.</td>
</tr>
<tr>
<td>Palm Pre</td>
<td>This selection should be used when exporting video for playback on a Palm Pre.</td>
</tr>
<tr>
<td>3G Phone</td>
<td>This selection should be used on earlier model mobile phones which support MPEG-4 video and AMR audio.</td>
</tr>
<tr>
<td>Digital Video (DV)</td>
<td>This selection should be used to create a DV file that can be imported and further edited with iMovie, iDVD, Final Cut Pro or Final Cut Express.</td>
</tr>
<tr>
<td>High Definition Video (HDV)</td>
<td>This selection should be used to create a high definition DV file that can be imported and further edited with iMovie, iDVD, Final Cut Pro or Final Cut Express. This option will only be available if a recent version of iMovie is installed on your system.</td>
</tr>
<tr>
<td>H.264 Player and MPEG-4</td>
<td>These selections can be used for portable players and devices which do not have an explicit selection in the Device list.</td>
</tr>
<tr>
<td>QuickTime Movie</td>
<td>This selection should be used to create a QuickTime (MOV) video.</td>
</tr>
</tbody>
</table>
Selecting this option will convert and upload video in your project to YouTube for sharing online. When using this option you will be required to provide your YouTube account information, along with video category, description, and tags. If multiple videos are being uploaded to YouTube at the same time, they will all share the description and tags you have provided. You can change details for videos that you have uploaded on the YouTube website. For more information on the types of videos which are appropriate for posting to YouTube, along with the YouTube Privacy Policy and other important information, visit www.youtube.com and review the Terms of Service.

<table>
<thead>
<tr>
<th>Device Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>YouTube</td>
<td>Selecting this option will convert and upload video in your project to YouTube for sharing online. When using this option you will be required to provide your YouTube account information, along with video category, description, and tags. If multiple videos are being uploaded to YouTube at the same time, they will all share the description and tags you have provided. You can change details for videos that you have uploaded on the YouTube website. For more information on the types of videos which are appropriate for posting to YouTube, along with the YouTube Privacy Policy and other important information, visit <a href="http://www.youtube.com">www.youtube.com</a> and review the Terms of Service.</td>
</tr>
<tr>
<td>Flash Video</td>
<td>This selection will convert your video into FLV or F4V video for viewing with Adobe Flash Player through a web browser.</td>
</tr>
<tr>
<td>Flash Video with Player</td>
<td>This selection will convert your video into FLV or F4V video for viewing with Adobe Flash Player through a web browser. When using the with Player selection, 3 additional files will be created in the destination folder. These 3 files combined with your exported video give you everything you need to post your video on a web page including playback controls and sample HTML code to embed the video on the page.</td>
</tr>
</tbody>
</table>
Changing copy options for a portable player

If you are converting a DVD-Video source for a portable player, you can choose which audio and video to include. Although some video on a DVD-Video may contain multiple audio tracks and languages, when converting this video for a portable player, only one audio track can be selected. By default, the main video and audio are included.

To change the conversion options:

1. In the content area, click Options.

   **Note** These options are only available if your source is DVD-Video.

2. Select the **Video** pop-up:
   - Choose **All** to include all video.
   - Choose **Main** to only include the single longest running video.
   - Choose **Custom** to select individual videos.

   If the Apple DVD Player software is installed on your Mac, you can preview a video by clicking on the small play button on the thumbnail of the video.

   By default, the primary audio is automatically selected for each video. If you select Custom as your Video choice, you can choose a different audio option for each video.

   **Note** Videos converted for portable players can only have one audio track and do not contain subtitles or menus. Multi-channel audio tracks will also be downsampled to two channels.

3. Click **OK** to continue and proceed with your copy.
Converting Audio

The Audio Files project will allow you to convert one or more audio files into another format.

1. To convert audio, launch Popcorn and select the Audio Files project Convert project category.

2. Add audio files to the project by dragging and dropping them into the Content Area from a Finder window or the Media Browser.

3. Click the red Record button.

4. Choose one of the available conversion formats:
   - **AIFF**: Creates a full quality uncompressed audio file for use on a Mac.
   - **WAV**: Creates a full quality uncompressed audio file for use on a PC.
   - **AAC**: Creates a high quality compressed audio file supported by iTunes.
   - **Apple Lossless**: Creates a full quality compressed audio file supported by iTunes.
   - **OGG**: Creates a high quality compressed audio file, similar to MP3. Your player will need Ogg Vorbis support. iTunes does not support Ogg Vorbis.
   - **FLAC**: Creates a full quality compressed audio file. Your player will need FLAC support. iTunes does not support FLAC.

5. Select a destination for your converted audio.

6. Click **Save** and your audio will be converted.

**Tip:** You can add most supported video files to an Audio Files project. Instead of your video being converted to a video format, the sound from your video will be converted to an audio file.
Troubleshooting tips

If you receive errors while recording using Popcorn, try any of the following tips to resolve the problem:

- Save your project as a disc image file on your hard disk. After you create the image file, you can copy it to a disc.
  
  For more information, see Creating a disc image file on page 16.

- Make sure that your computer is not going to "sleep" before Popcorn’s compression process is completed. Adjust the Sleep options in the Energy Saver System Preference.

- Burn at a slower speed. In the Recording Settings dialog, choose “1x” as the Write Speed. If the disc burns successfully, try choosing “2x” the next time, then “4x,” and so on.

- Try a different brand of blank DVDs. Make sure to use reliable media from a leading manufacturer.
  
  See http://www.nomorecoasters.com for suggestions.

- Try a different recorder. If your recorder is consistently giving errors, it may be failing. Choosing a different recorder may give better results.

- Try running fewer applications on your computer while burning.
  
  Avoid processor-intensive tasks while burning.

- Do not modify the source files while preparing the disc or recording it. For example, do not move or rename the files.
Support options

Unlimited self-help options
Roxio provides a variety of self-help tools, including our virtual agent, a searchable knowledge base of support articles with troubleshooting tips, and discussion forums with other users that can help you get the most out of your Roxio products.

You’ll find answers to most of your questions at http://support.roxio.com, or you can choose Help > Product Support from within Popcorn.

Alternate support options
Alternate support options such as e-mail or telephone support may be available on a limited or paid basis for your Roxio product. Please visit our Web site at http://support.roxio.com to find out what options are available for your product.

Contacting Roxio
Log in to our Customer Web portal to submit a request for assistance or to find support contact information for your location.

You can find the customer Web portal at http://selfserve.roxio.com.